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Цел на ръкводството

This Accessible Guidebook will serve as a
valuable resource for the implementation of  the
Poidcast Buddies project and its goals. The
basic purpose of  this result is to increase
accessibility and inclusiveness of  pwID in the
field of  digital and environmental education, as
well as volunteers with different backgrounds
(e.g., cultural, age, etc.). By developing this
guide, the project consortium hopes to give
pwID and volunteers the chance to learn how to
organize their own podcasts, how to use the
necessary tools and equipment for the podcast
production as well as other useful tips on how to
speak publicly especially regarding
environmental issues. One of  the most valuable
aspects is the fact that pwID will have the
chance to learn how to organize and implement
their own podcast with or without support. Apart
from these benefits, the development of  this
result will be beneficial also for the general
public and especially those who are eager to
organize their own podcast or podcast series.

ВЪВЕДЕНИЕ
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People with Intellectual disability

(pwID).

Volunteers supporting pwID.  

Organizations empowering pwID.

Organizations promoting

Volunteering.

Professionals/Educators working

with pwID – They need to build

their capacity towards digital &

green skills and methodologies

for educating pwID on them.

Who Is This Guide For?
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News
Entertainment
Education
Personal development
Marketing 

The term "podcast" is a
combination of  "iPod" and
"broadcast." It was first coined in
2004 by journalist Ben
Hammersley and it's now an
essential element of  the digital
landscape. While podcasts have
been around for over a decade,
their popularity has recently
surged due to the rise of
smartphones and audio
streaming platforms(Wix, n.d.).

Any digital media file, or series of
files, distributed over the internet
for playback on portable media
players and personal computers
(Lonn and Teasley 2009:88).

Podcast 

Potential Topics Covered:

Podcast 
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Podcasts offer a unique
opportunity to reach a large
and engaged audience.
By creating a podcast,
businesses can connect with
their target audience in a more
natural and engaging way
(Hanan, 2024)

Podcasts serve as useful tools
to promote:       

discussion, 
information, 
education, 
awareness 

  Some topics could cover: 
Arts and music, 
science and technology,
culture, 
Environment

One of  the most important fields
that podcasts can and should
contribute to is the field of
environmental issues and climate
change

Podcast 
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Aside from the growing success and use of
podcasts globally, the comparatively easy and
cost-efficient production and distribution tools for
podcasts are seen as one of  the main reasons for
the growth in podcast production (Berry, 2015;
Newman & Gallo, 2019).
    
In the following chapters we will explore some of
the most prominent and crucial environmental
issues of  our modern society.

As the years are passing by,
we are constantly hearing
and learning about various
environmental issues that
arise due to multiple
factors.The European
Environment Agency informs
that Europe is persistently
facing problems in various
sectors.

The European Environment
Agency (EEA) is an agency
of  the European Union and
provides valuable insights on
the state of  Europe's
environment (European
Environment Agency, 2025).

Why to use podcasts to address
environmental issues?
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Biodiversity loss

Resource use 

The impact of  climate change 

The environmental risks to our

health and well-being

Environmental problems:

As those problems grew, the
necessity of  sustainability
and sustainable practices
emerged. The development of
a European sustainability
competence framework is
one of  the policy actions set
out in the European Green
Deal as a catalyst to promote
learning on environmental
sustainability in the European
Union (Bianchi, Pisiotis, &
Cabrera Giraldez, 2022). 

Meeting the needs of  the
present without compromising
the ability of  future generations
to meet their own needs.

Sustainability:
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GreenComp is a reference
framework for sustainability
competences. GreenComp
identifies a set of  sustainability
competences to feed into
education programmes to help
learners develop knowledge,
skills and attitudes that
promote ways to think, plan
and act with empathy,
responsibility, and care for our
planet and for public health
(UNESCO-UNEVOC, n.d.).

Embodying Sustainability
Values (valuing sustainability,
fairness, and nature),
Embracing Complexity in
Sustainability (systems
thinking, critical thinking, and
problem framing), 
Envisioning Sustainable
Futures (futures literacy,
adaptability, and exploratory
thinking), 
Acting for Sustainability
(political agency, collective
action, and individual
initiative).

Competencies Defined
by GreenComp:
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The emergence of  Podcasts in
our lives, especially during the
last years, creates a fertile
ground in terms of  having an
additional tool/medium to raise
awareness and advocate for
various environmental issues.
While the need for a more
thorough reporting of  the
climate crisis is often still
prevalent in mainstream media
today, the genre of  climate
podcasts has been growing in
the past periods (Neubauer &
Ulrich, 2021; Salazar, 2011). 

Since environmental issues are
a topic of  general interest,
discussing them in a podcast
format can serve as an
engaging and accessible way to
attract and raise public
awareness, educate the
audience, and inspire collective
action (Mulki & Ormsby, 2021).
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Understanding Environmental Issues

Climate change:

Refers to long-term shifts in
temperatures and weather
patterns. Some of  these shifts
can be natural, due to changes
in the sun’s activity or large
volcanic eruptions. Even though,
since the 1800s, human
activities have been one of  the
main contributors of  climate
change, primarily due to the
burning of  fossil fuels like coal,
oil and gas. Burning fossil fuels
generates greenhouse gas
emissions that act like a blanket
wrapped around the Earth,
trapping the sun’s heat and
raising temperatures (United
Nations, n.d.).

Climate change:

14



Understanding Environmental Issues

Air Pollution:

Air pollution is the contamination of
the indoor or outdoor environment by
any chemical, physical or biological
agent that modifies the natural
characteristics of  the atmosphere.
Air pollution is the consequence of
different actions and is affected by
various sources such as household
combustion devices, motor vehicles,
industrial installations, forest fires and
others that have a direct impact on it.
Some of  the most significant and
dangerous pollutants in terms of
public health risks include carbon
monoxide, ozone, nitrogen dioxide,
and sulfur dioxide. Almost all of  the
global population (99%) breathe air,
exceeds the guidelines set by WHO in
terms of  pollution limits and contains
high levels of  pollutants.The quality of
air is relevant to the Earth’s climate
and ecosystems globally (World
Health Organization, n.d.). 

Air Pollution:
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Loss of Biodiversity:

Biodiversity loss refers to the
reduction of  any aspect of
biological diversity (i.e., diversity
at the genetic, species and
ecosystem levels) in a particular
area through death (including
extinction), destruction or manual
removal; it can refer to many
scales, from global extinctions to
population extinctions, resulting
in decreased total diversity at the
same scale (IPBES, no date).

Loss of Biodiversity:
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Environmental Podcasts: Examples

In the following table you can find some examples of
environmental podcasts

Podcast Title:

Creators:

Topics:

Outrage + Optimism: The Climate Podcast 

Christina Figueres, Tom Rivett - Carnac and Paul Dickinson

Climate Change:
You can find there episodes explaining the term “Climate
Change” itself, basic information and what we as citizens can
do about it. Moreover, there are many episodes covering
politics, top climate change news, Climate Change
Conferences and key decisions etc (Outrage + Optimism, n.d.).

Podcast Title:

Creators:

Topics:

Sustainababble

David Powell and Oliver Hayes

The podcasters deliver the topics of  environment and
sustainability in a light way that might be interesting for people
who want to get to know more but get bored or discouraged by a
more serious way of  delivery. The episodes focus on specific
topics, people, countries or phenomena. Additionally, they
provide some Q&A sessions which involve the listeners and let
them ask about things that haven’t been covered in the podcast
or were too hard to understand (Sustainababble, n.d.).
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Podcast Title:

Creators:

Topics:

Forces For Nature

Crystal DiMiceli

The host focuses on answering the question “What can we do
about the environment”. Instead of  showing basic information
she presents solutions and ways on how we can act in our daily
life. The episodes consist of  interviews with different people who
have creative ideas on how we can make a difference (Forces for
Nature, n.d.). 

UNDERSTANDING ENVIRONMENTAL ISSUES

Here you can also find a list with some of  the most famous
environmental podcasts (Robinson, 2024):

Click Here

https://earth.org/top-environmental-podcasts/

Podcast Title:

Creators:

Topics:

The Food Fight

Matt Eastland and Lukxmi Balathasan

Examines the food system from an environmental perspective.
They talk about sustainability, innovations and climate
change. It presents different ideas on how the food industry is
changing and which of  these ideas are more eco-friendly (EIT
Food, n.d.). 
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In this chapter, some useful instructions will be presented on
how to create a podcast step by step. There are various
parameters that can lead your podcast creation and also ensure
its success. Let’s explain some of  these parameters so the
readers of  this Accessible Guide will have the opportunity to
have a deeper understanding of  the process of  creating a
podcast(Copple, 2025).

Podcast Creation: Step-by-Step Instructions

This step is the most crucial since
it will give them the chance to
attract their audience. In order to
be able to define their topics,
podcast creators need to make an
analysis of  their target group and
do research (interview, focus
group etc) through which they will
gain insights regarding the interest
of  their audience.

Step1: 
Define the podcast Topic
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Ask yourself: “Who are you making
this podcast for?”, “How much
knowledge of  the topic does the
audience have?” , “What tone is right
for this audience?”. These are some
indicative questions which will help
podcast creators to better identify
their target audience and their
needs, but also will help them
decide and define their podcast’s
main topic.

Step 2:
Get to know your audience

Decide if  you would like to create a
podcast with video or only with
audio. This is crucial for the setup
and production of  a podcast since
the video creation has more
technical requirements and it could
be more costly. Our podcast creators
should also have in mind that they
should feel confident in themselves
regarding the topic and the format of
their podcast in order to be
successful.

Step 3 :
Decide on the podcast format

PODCAST CREATION: 
STEP-BY-STEP INSTRUCTIONS
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Choose something concise and easy
to remember. The title of  your
podcast should also reflect somehow
the tone of  your show. More
specifically, the title of  your show
should define if  it's about a serious
podcast, humorous etc. This is
something that will make your
podcast show unique, and it is really
important for the potential audience,
in order to get attracted by your
podcast.

Step 4 :
Choose a proper Title

Step 5 :
Create a description of your
show
The description should include some
of  the following elements:
1. What is the podcast about?
2. Write a few words about it. 
3. Mention the audience of  the
podcast. 
This information could be included in
the description of  your podcast,
making it easier for your audience to
understand if  the topic is of  their
interest.
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The cover/artwork of  the podcast can
act as a complementary element,
offering more information about the
podcast but at the same time making
it more appealing to the audience
which can understand if  the topic is
interesting for them or not. Podcast
creators can either use free online
tools for artwork and visuals creation
like Canva, or hire a professional
designer to make it for them.

Step 6 :
Use an Artwork for the podcast

Step 7 : 
Getting the Equipment

In general the cost of  the podcast
equipment lies between 150-200
euros. The necessary equipment
consists of:

A microphone,
A pop filter (reduces undesired
sounds like the “p” sounds and
also protects your microphone
during the recording process), 
Over the ear headphones,
Audio interface (not always
mandatory).

ACCESSIBLE GUIDEBOOK22PODCAST CREATION: 
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a) Use a dynamic
microphone (this
microphone requires
additional equipment in
order to connect it to the
computer, which is called :
audio interface). 

b) Use a USB microphone
which can directly connect
to the computer.

If  the podcast includes
guests or co-hosts, pairs
of  over the ear
headphones are required
in order to hear them
without their audio being
picked up by the
microphone

Microphone Options
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Step 8 :
Script and organization of the
podcast 

Podcast creators should outline
their ideas in order to be aligned
with their co-hosts or collaborators.
In general the script is dependent
on the type of  the podcast and the
episode’s length. Even so, there are
some specific guidelines for the
definition of  the script. The following
structure could be followed:

a) Introduction

b) Welcome the guests

c) Segue (this term refers to the
smooth and uninterrupted
transition from one
issue to another).

d) Topic for discussion

e) Outro

ACCESSIBLE GUIDEBOOK24PODCAST CREATION: 
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Choose the proper software for
podcast creation.
Set up the recording equipment. 
Share invitations to the guests by
sharing the link of  the podcast
session. 
Start the recording.
Speak in a clear and natural way. 
After the recording process of  the
episode, the recordings are stored
in the computer. 
Edit the audio or video of  the
episode before making it available
online. During this process, they
will have the chance to edit the
material and cut any unnecessary
sounds or moments that came up
during the recording. 
Various editing tools support
multitrack editing, allowing users to
cut, rearrange and layer different
audio sources. These tools also
offer background reduction (e.g.
street noise, barking dogs,
etc.).The last step is to finalize the
material and make the podcast
public. 

Step 9 : 
Recording of the podcasts
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Find an appropriate way to
promote it. 

Choose a hosting platform. 
In the list below, we present some
of  the most known podcast hosting
platforms:

Spotify

Youtube

Podbean

Acast

Buzzsprout

Step 10 : 
Host the Podcast

ACCESSIBLE GUIDEBOOK26PODCAST CREATION: 
STEP-BY-STEP INSTRUCTIONS

https://www.outrageandoptimism.org/
https://www.outrageandoptimism.org/
https://www.outrageandoptimism.org/
https://www.outrageandoptimism.org/
https://www.outrageandoptimism.org/
https://www.outrageandoptimism.org/
https://www.outrageandoptimism.org/
https://www.outrageandoptimism.org/
https://creators.spotify.com/
https://www.youtube.com/
https://www.podbean.com/?utm_term=podbean&utm_campaign=2023.6.14-SEM-Brand-US&utm_source=adwords&utm_medium=ppc&hsa_acc=7290415782&hsa_cam=20286399798&hsa_grp=150853636936&hsa_ad=663108668558&hsa_src=g&hsa_tgt=kwd-298034660538&hsa_kw=podbean&hsa_mt=e&hsa_net=adwords&hsa_ver=3&gad_source=1&gclid=Cj0KCQiAkoe9BhDYARIsAH85cDO2qiuauDUmLET_KjB7-p5kUwoYXoVe6ohQmCjxZFF7aD-RiyEIFIQaAjpGEALw_wcB
https://www.podbean.com/?utm_term=podbean&utm_campaign=2023.6.14-SEM-Brand-US&utm_source=adwords&utm_medium=ppc&hsa_acc=7290415782&hsa_cam=20286399798&hsa_grp=150853636936&hsa_ad=663108668558&hsa_src=g&hsa_tgt=kwd-298034660538&hsa_kw=podbean&hsa_mt=e&hsa_net=adwords&hsa_ver=3&gad_source=1&gclid=Cj0KCQiAkoe9BhDYARIsAH85cDO2qiuauDUmLET_KjB7-p5kUwoYXoVe6ohQmCjxZFF7aD-RiyEIFIQaAjpGEALw_wcB
https://www.acast.com/
https://www.acast.com/
https://www.buzzsprout.com/


1. Individual Podcasts
or Solo episode

Types of podcasts

Podcasts Categories :

Definition: Refers to a form
of  podcast in which there is
only one speaker, hosting
the whole podcast, defining
the topic of  discussion for
the episode and sharing
his/her perspective on the
specific topic (Kingland,
2024). 

2. Podcasts with
multiple hosts or
participants.

Consist of two or more co-
hosts discussing a specific
topic, without a designated
interviewer or interviewee
(Santo).
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Advantages:
1.Μake the creation process

easier since the scheduling
of the recording is much
easier than with guest
speakers.

2.Give the hosts the chance
to discuss whatever they
want. 

Disadvantages:
1.Host and co-host may easily

go off on irrelevant topics. 
2.This could confuse the

audience and create
frustration to those willing to
listen and learn about a
specific topic, preventing
them from listening to future
episodes. 

How to avoid going off topic: 
1.Clearly define and create

the outline of the podcast. 
2.Have a copy of it during the

podcast process to avoid
any off-topic references and
discussions.

ACCESSIBLE GUIDEBOOK28PODCAST CREATION: 
STEP-BY-STEP INSTRUCTIONS



3. Interview - style podcasts

Definition: One or more people are
invited by the main speaker to have a
conversation in the form of questions
from the host and answers from the
guest.
This podcast format requires: 

More preparation time.
Pre-defining the questions for the
upcoming interview and. 
Finding suitable guests. 

Interview-style podcasts are mainly
adopted by podcast series, where
each episode presents a new guest
offering a new point of view to discuss
the central theme of the series (Berg,
2021).

4. Narrative podcasts
Α series of  podcasts based mainly on
the narration of  a story which could
either be factual or fictional, across
the realization of  multiple episodes.
Narrative podcasts follow a structured
plot, and the host or narrator of  the
podcast, guides the listeners through
the narration (Tella, n.d.).
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Key Steps:

1.Develop a strong concept/narrative,
ensuring the script provides a
structured flow.

2.Present a story, usually a complete
story or a personal experience of
the narrator.

3.Use sound effects, music, and
possibly combine audio segments
from other media or individuals
when they help tell the story
(Lindgren, 2016).

Involve the participation of  the
podcast creator/host as well as the
participation of  various and multiple
experts at the same time.  
  
Main purpose:
Promote discussion between the host
and the guest experts in order to
enhance the audience engagement
through the presentation and
discussions of  different perspectives
related to the topic. 

5. Panel podcasts
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Depending on the guests'
dynamics, this category of  podcast
can take various forms. Some of
the most common panel podcast
formats are (Kingland, 2024):

Round-robin: At this format of
podcast, every guest has to
answer each question asked by
the host.

Panel podcasts -
Requirements

 Requires a lot of  preparation by
the host before the meeting. 

Skill of  being able to make
interviews with multiple people at
the same time. 

Research related to the main topic
of  discussion but also related to
the guest-experts. 

Conduct some preparatory
interviews with their guests.  

Create a structured outline of  the
episode.
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Debate-style: This format is
more common when there are
opposing viewpoints regarding
the main topic of  the debate.
Expert-led: This format is
usually used when the
guest/experts of  the podcast
have specialized knowledge
and expertise in a different
area of  the main topic.

Educational podcasts are
usually intended to "train" the
listener in a new skill. They
are a useful tool, both for
personal use by the public
and for the education sector,
where teachers and lecturers
use them to educate and
inform students on specific
topics (Drew, 2017).

6.Educational podcasts

ACCESSIBLE GUIDEBOOK32PODCAST CREATION: 
STEP-BY-STEP INSTRUCTIONS



Brainstorming about podcast ideas

3 Planning the episodes

Before podcast creators proceed to
the actual podcasting process, a key
consideration they should have in
mind is the definition of  their topic.
This activity needs to follow a
brainstorming process taking into
account many issues. When it comes
to the selection of  the topic, podcast
creators should be very careful since
there is a difference between the
theme that underpins it and the
individual episodes that are going to
be released (The Podcast Host, n.d.).
The theme is the overarching category
e.g environmental awareness, and the
episodes go into detail in relation to
the central theme. A podcast must
have a theme that is of  interest to the
creator and beneficial to listeners.
Once an idea is solid, it can then be
structured into episodes or seasons
focusing mainly on enhancing
audience engagement (McLean &
Errey, 2023).
In the following table there are some
guidelines about the definition of
theme and topics for a podcast:

Brainstorming about podcast

ideas
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Brainstorming about podcast ideas

3 Planning the episodes

Ask yourself: Why do you want to
start a podcast?
Determine the purpose and the
goals.

There are many reasons to start a
podcast. 

For example, a podcast can provide: 

Fun 
Knowledge
Awareness

1. Definition of purpose

2. Selection of the overall
podcast topic

Select a subject that is interesting to
you and that you feel familiar with.

This will be beneficial in terms of
long-term consistency and
maintenance. 

Choose an appealing subject to
attract a wide range of  audience.
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After the main subject of  the
podcast is determined, you should
analyze and break it down into
topics for individual episodes.

After the main subject of  the
podcast is determined, you should
analyze and break it down into
topics for individual episodes.

Decide on the format and style of
the podcast. (This is based on the
creator's needs and expertise). 
The formats that you could follow
may be: 
Individual Podcasts,
Podcasts with multiple hosts or
participants,
Interview - style podcasts, 
Narrative podcasts, 
Panel, 
Educational podcasts. 

4. Format & Style

3. Planning the episodes

Style

“Style” refers to the way the content
and episode will proceed e.g.,
scripted or semi-scripted content
during the podcast. 
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Style

Here you can find a template that will
help you brainstorm ideas for your
podcast:https://library.dwu.edu/ld.php?
content_id=59594547

Brainstorming Template

The creation of  a podcast requires a
lot of  preparatory work in order to be
successful. In addition to preparing the
equipment and the research and
rehearsals done by the speaker(s),
another key element needs to be
carefully addressed. This is the
script/scenario of  the podcast. 

Writing a Podcast
Scenario/script

In general, the script of  a podcast is
an outline of  what takes place during
a podcast episode. The scripts of  the
podcasts do not necessarily have to
be lengthy and detailed but they
should be adapted to the needs of  the
podcast creators (e.g., their
experience) but also to the format of
the podcast they have chosen to
create (Breitman, 2025).

Podcast Script/Scenario
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Style

The use of  a podcast script, can help
you:

Help you sound more confident and
professional.

Keep your episode focused and
structured.
Make editing easier since there’s
less off-topic content to cut out.

Why to use a Script?
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In the following Table, you can find the most
Essential Parts of a Podcast Script.

Start your podcast with an
introduction

Briefly explain the episode’s
theme.
Keep a consistent structure
every week, even if  the content
changes.

Example:
 "Hello and welcome to [Podcast
Title], the show that [insert
concept]. I'm [Host Name]."

Introduce your guests.
Share a bit about their background
and expertise.
Make them feel welcome and
appreciated.
Example: "Today's guest is [Guest
Name]. They are a [role, title, or
experience] with a passion for [topic].
We’re thrilled to have them here to
discuss [episode topic]. Welcome,
[Guest First Name]!"

Intro

Guest Intro (If you have
guests)
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Wrap up the main points of  the
episode.

Recap the key takeaways so
listeners leave with a clear
message.

Give a brief preview of  the next
episode.
Share resources or links related to
the topic.

End the episode with a proper
closing.

Segue

The term “segue” refers to a smooth
transition between topics.

Can be a sound effect, musical
break, or short phrase (can be
added during editing),
Helps create a flowing and
cohesive episode.

Summary

Outro
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Ask your listeners to do one clear
thing (like follow you on social
media or leave a review).
Keep it simple and direct to avoid
overwhelming them.
Example:
"If  you liked our episode, follow us
on [Social Media]!”

Call to Action
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Examples of podcast script Templates

The following table includes some examples and templates
for your interview-style podcast’s scripts.

Before the Interview
Send your guest an outline about
a week before the interview.

Share the questions you plan to
ask so they have time to prepare.

Script Layout

You could start with a music intro to
set the mood.

Speaking Intro

Get your listeners’ attention with a
quick overview of  the episode.

Give an overview of  what they’ll
learn or hear.
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BEFORE THE INTERVIEW

Guest Introduction
Share some information about your
guests. This information should
include:

Their name
Role
Accomplishments or expertise

Example: 
"Today, we're joined by [Guest
Name], a [profession] with a passion
for [Topic]. He/she managed to
[Mention Accomplishment] and
he/she is here to share his/her
insights with us!"

Select questions that encourage a
natural conversation.

Question #1: (Duration: ____)
Question #2: (Duration: ____)

Interview Questions

Episode Recap & Closing
Remarks

Summarize the main points from
the interview.
Thank your guest for joining.
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Sneak Peek of Next Episode
Give a preview of  your next episode
to your audience.

Call to Action
Close your episode by asking your
audience for one clear thing to do
after listening.

Example:

"If  you enjoyed this episode, make
sure to follow us on social media!"
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https://www.ausha.co/blog/podcast-
script-templates/

In case you would like to follow a different podcast style, you
can choose the script template that works best for you in the
following list:

Podcast script Template

https://docs.google.com/document/d/
17hboqfyGpAlOBCzpC1trNGgwcIzo
Wpja2n1D5faFwdQ/edit?
tab=t.0#heading=h.x4m1vhj7ho0d 

Different podcasts scripts for different
styles of podcasts

https://www.buzzsprout.com/blog/writ
e-podcast-script-examples

Free podcast script and/or outlines
for a variety of podcast styles

In the following section our podcast creators can find a source
of  inspiration for their podcast scenarios, based on some
indicative environmental topics and websites which can be
really helpful in terms of  the creation of  the scenario.

Click Here

Click Here

Click Here
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Indicative Environmental Topics

Climate
Change

Air 
Pollution

Deforestation
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Noise
Pollution

Biodiversity
loss

Plastic
pollution
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Indicative Environmental Topics

Water
Scarcity

Industrial
Agriculture
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Soil Degradation

Websites/podcasts to assist podcast creators in the
script creation process:

WEBSITE LINKWEBSITE LINK

United Nations:
What is climate
change

https://www.un.org/en/climatechang
e/what-is-climate-change

NASA: Climate
Change

https://science.nasa.gov/climate-
change/

European
Commission:
Deforestation

https://environment.ec.europa.eu/t
opics/forests/deforestation_en
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Soil Degradation

National
Geographic:
Deforestation

WWF:
Deforestation

https://education.nationalgeographic.
org/resource/deforestation/

https://www.worldwildlife.org/threats/d
eforestation-and-forest-degradation

World Health
Organization:
Biodiversity

https://www.who.int/news-room/fact-
sheets/detail/biodiversity

United Nations
Office for
Disaster Risk
Reduction:
Biodiversity
Loss

https://www.undrr.org/understanding-
disaster-
risk/terminology/hips/en0008#:~:text=B
iodiversity%20loss%20refers%20to%2
0the,global%20extinctions%20to%20p
opulation%20extinctions%2C

https://www.unep.org/plastic-pollution UN
Environment
Programme :
Plastic
Pollution
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Unicef: Water
Scarcity

https://www.unicef.org/wash/water-
scarcity

National
Geographic:
Plastic
Pollution

https://www.nationalgeographic.com/
environment/article/plastic-pollution 

WWF: Water
Scarcity

https://www.worldwildlife.org/threats/
water-scarcity

United
Nations
Office for
Disaster Risk
Reduction:
Soil
Degradation

https://www.undrr.org/understanding
-disaster-
risk/terminology/hips/en0005 

Science
Direct: Soil
Degradation

https://www.sciencedirect.com/topics/
earth-and-planetary-sciences/soil-
degradation
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European
Environment
Agency:
Noise
pollution

https://www.eea.europa.eu/themes/h
uman/noise/noise-2 

https://environment.ec.europa.eu/to
pics/noise_en

European
Commision:
Noise
pollution

UN
Environment
Programme
Industrial
Agriculture

https://www.unep.org/news-and-
stories/story/10-things-you-should-
know-about-industrial-farming

Indeed:
Industrial
Farming

https://www.indeed.com/career-
advice/finding-a-job/industrial-
farming
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Indicative questions for environmental
podcasts

?

?

What are the most significant
environmental challenges facing our
planet?

How can individuals contribute to
environmental conservation?

? What are the implications of
overpopulation on global resources, and
how can they be managed?

? What roles can individuals play in
addressing global challenges?
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Podcast interview questions on global trends

?

?

?

How are shifts in global energy infrastructure
influencing national and international energy
policies?

What role does international collaboration
play in addressing biodiversity loss and
ecosystem degradation?

What lessons have been learned from global
responses to climate crises, and how can
they be applied for future challenges?

Skills and Mindset for a successful Podcast

In the following link you can find a list of  possible questions to
choose from, for your podcast:
     
https://maestra.ai/blogs/100-great-podcast-interview-questions

When it comes to the creation and
realisation of  a podcast, our podcast
creators should have some skills to
make a successful podcast. A key
factor is the self-confidence of  the
podcaster, as well as other skills.

Skills for a successful podcast

SKILLS AND MINDSET FOR A SUCCESSFUL PODCAST
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Many podcasters experience Public
Speaking Anxiety. This can make them
feel less confident because of:

Fear of  being judged

Lack of expertise

Performance pressure

The good news is that self-
confidence can be built with the
right strategies and mindset
(Podium, n.d.).

Here are some practical ways to feel
more confident while podcasting:

1. Practice Makes Perfect
Anxiety often comes from not being
familiar with the topic.
Whether you use a scripted or
unscripted format, take time to get
familiar with your content.

Ways to Practice:
Practice speaking in front of  a
mirror.
Record a mock session and listen
back to it.

Self-Confidence

Practical ways
to feel more
confident while
podcasting:
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Do a few test recordings to
check sound quality.

Adjust the microphone settings
for optimal audio.

Learn the software interface to
avoid last-minute stress.

Microphones

Headphones

Recording software

Getting Comfortable with Equipment

Another common reason for anxiety is not knowing how to use
podcast equipment.

Tips to Get Familiar:

As a podcaster, you’ll be handling:
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Organization and Planning Skills

As mentioned above, there is a series of  necessary skills that
ensure the high quality of  the podcast episode. Podcast
creators need to have and develop strong organization and
planning skills in order to succeed. 

Organization and Planning Skills
Podcast creators need to have and
develop strong organization and planning
skills. The creation of  a well-structured
plan describing the topics, the timeline
and the podcast vision could prove
beneficial in terms of: 

Increasing the self-confidence of  the
speaker. 
Ensuring the podcast's success
ensuring that the podcast remains on
track and positively affects the
engagement of  the audience.
Assisting in the creation of  a community
around the podcast. (Horn, 2023)

Research is not limited to the topic itself.
Start with the research on the audience.
It is really important for the research and
development of  your content.
Define the target audience.  
What are their interests?
What type of  content would they prefer?
(Horn, 2023)

Research Skills
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Audio Engineering Skills (for recording and
editing)

A general requirement for every podcast episode is a basic
understanding of  audio engineering.

Good audio quality is key to
attracting and keeping listeners.
Knowing the basics of  sound
engineering helps you:

Record clear and crisp audio.
Edit out background noise or
mistakes.
Master the final recording for
a professional finish.

Importance of audio
engineering skills

Recording: Editing and
Mastering

Audio engineering skills aren’t
just useful during recording.
They’re also essential when it
comes to:

Editing: Cutting out
unwanted parts and adding
effects.
Mastering: Balancing sound
levels and enhancing the final
output.
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Storytelling and interviewing Skills

n order for our podcast creators to successfully develop a
podcast, some basic skills need to be developed. More
specifically those skills are related to the capacity of  a
podcaster to narrate a story and take an interview. 

Storytelling
Storytelling is an essential
element for creating podcasts
that captivates listeners and
builds a community. No matter
what type of  podcast you’re
creating, good storytelling can:

Make your content more
engaging and relatable.

Help listeners connect with
your message.

Turn casual listeners into
dedicated fans.
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Interviewing Skills

Interviewing skills are especially
important if  you’re hosting a 1-
on-1 interview podcast like
“PoIDcast Buddies.” These
skills help you:

Craft thoughtful questions
that lead to interesting
conversations.

Put your guest at ease so
they feel comfortable
sharing their story.

Practice active listening to
guide the interview
smoothly.

Active listening is key because it
helps you:

Follow up naturally with
better questions.

Stay present and engaged
during the conversation.

Make your guest feel heard
and valued.
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Communication Skills

Communication Skills are crucial for a successful podcaster.
This set of  skills can assist podcast creators in terms of
better communicating their message to their audience.

Communication Skills

The development of  those skills
ensures that podcast creators
will be able to:

clearly express their ideas, 
listen intently, 
give proper answers 
ask the right questions

Asking the right questions can
prove beneficial in terms of
engaging the audience by
giving a really interesting
characteristic to your podcast.

Audience Psychology

During the last few years, podcasts have become a daily
routine for many listeners. Many listeners use podcasts
during various activities of  their daily lives, for example,
during their workout, household chores, or others. This is
something directly related to the psychological principle of
“economy of  action”, which is really important in today’s fast-
paced society (Hello Podium, n.d.).

ACCESSIBLE GUIDEBOOK60BEFORE THE INTERVIEW



Listening to podcasts offers
several benefits including:

Time-saving: You can listen
while doing other tasks.

Makes tasks enjoyable:
Activities feel less boring
with a podcast playing.

Personal connection:
Listeners often feel closer to
hosts and guests compared
to other media (like TV or
radio) and in this way they
can develop a personal
connection with the host and
the guests of  the podcast,
which is really beneficial
especially for people
experiencing isolation during
their everyday life (Moore,
2023).

Why do people love
listening to podcasts?
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Why do they love educational
and informative podcasts?

These types of  podcasts
(educational) can provide a
variety of  learning
opportunities, which can assist
listeners in their personal
growth and development as
well as further exploration related
to the topic of  the podcast
(Moore, 2023). One of  the main
reasons that listeners prefer
educational podcasts is the
factor of  human curiosity, but
also the pleasure people get
when they learn something new
(Hello Podium, n.d).

Psychological aspects

Podcasts have the potential to
fulfill some basic human needs
for:

Connection
Learning
Self-improvement  
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since they can combine all of
these in an appealing format
(Moore, 2023).
Podcasts also have the potential to
extend into offline and online
communities where listeners have
the opportunity to: 

Interact with each other by
exchanging opinions and
taking part in discussions.
Feel part of a larger
community, which is directly
related to the psychological
need of  belonging (Hello
Podium, n.d.) 

How to Engage Your Podcast Listeners

A successful podcast is determined
by various factors, e.g. the quality of
sound, the topic it addresses, and
others mentioned in previous
chapters. Another important aspect
that determines the success of  a
podcast is the number of  listeners
and their engagement. In the table
below you can find some ways to
engage your audience (Winter Audio,
n.d.).:
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Know Your Audience

Create Exceptional Content

To create engaging content, you
first need to understand your
audience.

Research your listeners’
interests, needs, and
preferences.
Choose topics that resonate
with them.
Keep content relevant and
interesting to maximize
engagement.

To make your podcast unique, focus
on delivering high-quality, engaging
content. Some ideas include:

Interviews: Bring on guest
speakers or experts for unique
insights.
Storytelling: Share captivating
stories that keep listeners
hooked.
Guest Appearances: Invite
people with different perspectives
to keep things fresh.
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Build Your Brand
Creating a strong brand is essential
for attracting and retaining listeners.
Podcast Title: Make it unique and
informative about your topic and
style.
Logo: Use a square image (1,400
to 3,000 pixels) as your channel
icon. A catchy logo helps your
podcast stand out in a crowded
space.

Promote Your Podcast

Promotion is crucial to reach more
listeners. Share your podcast on:

Using social media allows you to:

Podcast Platforms: YouTube,
Spotify, Apple Podcasts, Google
Podcasts, Amazon Music.
Social Media: Facebook, TikTok,
Instagram, and more.

Promote new episodes and
updates.
Interact with listeners through
comments and messages.
Get feedback, reviews, and
ratings to improve your show
(Shah, 2024).
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Build a Community and
Connect with your audience

Creating a sense of  belonging is
crucial in terms of  audience
engagement. This can be done
through (Winter Audio, n.d.):

Hosting interactive Q&A
sessions.
Setting up a dedicated group
or community for listeners.
Using email communication to
share updates and news.
Collaborating with other
podcasters or influencers.

Record & Edit Podcasts

In general, when it comes to podcast creation, the most crucial
thing that podcast creators will need is a microphone.
Depending on the quality of  your microphone, the quality of
the podcast sound may vary, so it is important to make the
right selection.

This type of  microphone is quite easy to
plug in and use, since it only requires the
microphone to be connected to your
computer's USB.

USB Microphone
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XLR microphones will not
physically plug into the
computer. In order to properly
connect it, podcast creators will
need an additional device called
a sound card or audio interface.

The use of  this device will let
podcast producers connect the
device (sound card) to their
computer and later the
microphone to it. This will make
the microphone readable by the
computer and allow them to
start the recording process.
Here you can find a video on
how to setup your devices:

Click Here
 

https://www.youtube.com/watch
?v=u_qCh3TIk8w 

XLR Microphone

Sound Card
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In order to be able to record any material on the computer, a recording
software is required. In the list below, we present some of  the available
recording software that you could use in order to record your shows:

FL Studio 

CUBASE
https://www.steinberg.net/cubase/ 

Audacity

https://www.audacityteam.org/ 

Reaper

https://www.reaper.fm/ 

Ashampoo
https://www.ashampoo.com/en-
us/audio-recorder-free?
srsltid=AfmBOoodtR7NGULGRcyr
yyGClAXS9XnqhrEllCppkTbeHzM
_Jq-cZZ0s 

https://www.image-line.com/ 

In the following section, we are going to demonstrate how to
install one of  these softwares (Audacity) and properly set it up
for the needs of  a podcast.
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Visit the Audacity official
website.

Click Here

https://www.audacityteam.
org

Step 1

How to install and properly setup your software:

Step 2

Download the software
(without Muse hub).

Step 3

Open the installation file.
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Step 4

Continue the installation
process.
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Step 5

Once the installation is
complete, launch the
software.

Set up your devices by
clicking on the “Edit”
button on the top bar menu
and then click on the
preferences button.
Find the section called
“Recording”. There you will
see a drop down menu for
“device”. Your microphone
will probably already be
recognized by the software
so there will not be a need
to do it manually, but in
case it is not recognizable,
you can just find your
microphone from the drop
down menu mentioned
above. 
Click “OK” and you will
move to the main screen of
the software.

Step 6
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Step 7
Start your recording. Once
you have finished setting up
your devices, you can now
start the recording process by
clicking on the red recording
button on the top bar.

Step 8

Create Multiple Channels. In
case you need to create
additional channels which is
something that significantly
could help in splitting the
various recordings, you can
just right click in the software
and add an additional channel
by clicking “add mono track”.

Step 9

Save your project before
starting the editing process,
since during the editing phase
you might delete something
that you will later decide that
you need.
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After you have recorded and saved your material, it's time to
start the editing process.

Editing

As mentioned before, at this stage we will present some of  the
main editing functions of  the Audacity software.

Editing Commands

The main editing tools are
found under the Edit Menu
and Effect Menu. You can
also use the Edit Toolbar
for quick actions like:

Cut: Remove selected
audio (Ctrl + X).
Copy: Duplicate selected
audio (Ctrl + C).
Paste: Insert copied audio
(Ctrl + V).
Delete: Remove selected
audio (Del).
Remember: Effects or edits
cannot be applied while the
audio is playing,
recording, or paused.
Stop the audio first!

73



BEFORE THE INTERVIEW

Applying Effects

To apply an effect, follow
these steps:

Select the Audio: Click
and drag to highlight the
part of  the track you want
to edit.
Choose an Effect: Go to
the Effect Menu and click
on the effect you want.
Adjust Settings: A
dialog box will open.
Adjust the settings as
needed.
Preview the Effect: Click
the Preview button to
hear how it sounds.
Apply: When you’re
happy, click apply. 

Tip: 

Try out effects on a short
section first to make sure
they sound good before
applying them to a larger
part of  the audio.
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Marking Edit Points

You can mark specific
spots or regions in your
audio to make editing
easier.

Add a Label: Go to your
track>select the area you
want and press Ctrl + B.
Name the Label: Type a
short description to
remember the edit point.
Use Labels to Split
Tracks: Helpful for
exporting long recordings
into separate files.

Undoing an Edit or
Effect

If  you don’t like the result,
simply Undo by pressing
Ctrl + Z or just select
Undo from the Edit Menu.
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Save Project
When the editing process is
completed then you should
Save and Export your file in
order to upload it and spread
it. From the top bar menu,
click File>Save Project

Export Project

To export the file, click
File>Export Audio.

Once you click the export
audio selection, a screen will
appear asking how you would
like to export. Click the option
“On your computer”.
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For the next step, choose a
proper file name and decide
where you want it to be
stored. Click “Export” and
your file will be ready very
soon. 

Name your project

On the following table you can find a video with useful instructions.

Video Instructions for editing the podcast

https://www.canva.com/design/DAGjpwhcuAY/90EcYIoUDs1oPe
GnBL3ZmA/edit?
utm_content=DAGjpwhcuAY&utm_campaign=designshare&utm_
medium=link2&utm_source=sharebutton

Click Here
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Hosting and Promotion

Hosting Platforms

After you have completed the
recording and editing process
of  your podcast, it's time to
upload it and start its
promotion. The place where
you can upload your material
is known as “hosting
platforms”. 

Podcast hosting platforms
consist of  a service that is
able to store and promote the
podcast episodes to various
streaming directories like
Spotify, Amazon music and
others. Those platforms create
an RSS feed (Really Simple
Syndication) which is a file
with all podcast data and
material, and through this, the
podcast episodes are
becoming available to the
audience (Dodd, 2023).

Below, there is a list with hosting platforms where
podcasts can be uploaded:
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Apple Podcast

HOSTING
PLATFORM

https://podcasts.apple.com/
us/browse

WEBSITE LINK

Simplecast https://www.simplecast.com/

Libsyn https://libsyn.com/

Megaphone
https://megaphone.spotify.c
om/ 

Captivate https://www.captivate.fm/si
gnup?ref=nzy3zdu

Buzzsprout https://www.buzzsprout.com/ 

Podbean https://www.podbean.com/

Casted https://www.casted.us/

In the following section there are some instructions on
how to upload your podcast on Youtube.

Youtube https://www.youtube.com/

Spotify for Creators https://creators.spotify.com/

79

https://podcasts.apple.com/us/browse
https://podcasts.apple.com/us/browse
https://podcasts.apple.com/us/browse
https://www.simplecast.com/
https://www.simplecast.com/
https://www.simplecast.com/
https://libsyn.com/
https://libsyn.com/
https://libsyn.com/
https://megaphone.spotify.com/
https://megaphone.spotify.com/
https://megaphone.spotify.com/
https://megaphone.spotify.com/
https://megaphone.spotify.com/
https://www.captivate.fm/signup?ref=nzy3zdu
https://www.captivate.fm/signup?ref=nzy3zdu
https://www.captivate.fm/signup?ref=nzy3zdu
https://www.buzzsprout.com/
https://www.buzzsprout.com/
https://www.buzzsprout.com/
https://www.podbean.com/
https://www.podbean.com/
https://www.casted.us/
https://www.casted.us/
https://www.casted.us/
https://www.youtube.com/
https://www.youtube.com/
https://www.youtube.com/
https://creators.spotify.com/
https://creators.spotify.com/
https://creators.spotify.com/


BEFORE THE INTERVIEW

Step 1: 

Visit the Youtube
Creators website
for podcasts:
https://www.youtub
e.com/creators/po
dcasts/.

Step 2: 

Click “create a
Podcast”.

Step 3: 

On the next screen
click “New
podcast”.

Step 4: 

Click “Create a
new podcast”.
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https://www.canva.
com/design/DAGjq
hQRxKY/bJr8jaQz
6wgC5X5pEf8kow/
edit?
utm_content=DAGj
qhQRxKY&utm_ca
mpaign=designsha
re&utm_medium=li
nk2&utm_source=s
harebutton

Step 5: 

On the next
screen, add the
title, the
description and a
thumbnail of  the
podcast and later
upload your video
file. Remember to
make your video
public (otherwise
it will be private)
and click
“Create”.
Your video is
uploaded and
ready for
promotion!

Instruction
Videos:
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CONCLUSIONS

CONCLUSIONS

The Accessible Guidebook of
PoIDcast Buddies can act as
an useful and inclusive toolkit
designed to empower people
with intellectual disabilities and
their supporters in order to
assist them in exploring the
world of  podcasting. This
guidebook offers practical
guidance regarding the podcast
production, the brainstorming
processes of  ideation for
podcasts as well as useful
examples of  already existing
environmental and educational
podcasts. More specifically, the
readers of  this guidebook will
have the chance to learn about
the different types of  podcasts,
and learn step by step the
process of  recording, editing
and promoting their podcast
episodes.
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CONCLUSIONS

Emphasis has been placed in
terms of  using the podcasts in
order to advocate for the
environment and analyze
environmental issues.
Furthermore, this guidebook
not only supports
environmental education, but
also strengthens digital and
sustainability related skills for
all readers. A crucial objective
that we wanted to achieve is to
make the guide accessible
enough for everyone who
wants to create their own
podcast episodes. We believe
that we achieved our goals and
we hope to listen to new
environmental podcasts from
those who read this Accessible
Guidebook.
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